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What you need
The WiggleWorks CD-ROM disc

An Apple Macintosh computer with

m at least 4 megabytes of memory (RAM)

m a hard disk with at least 4.5 megabytes of space available

m system software version 7.0 or later

m a color monitor that displays at least 256 colors and measures at least 
12 inches diagonally.

m a CD-ROM drive

You do not need the following as part of your computer system, but you may
find them useful:

m a printer

m a microphone

If you have what you need, go to the next section. If you’re not sure that you
have what you need, continue reading this section.
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If you don’t know how much memory your co mputer has 
and which version of system software it’s using:

1 Click the hard disk icon near the upper-right corner of the screen.

2 Pull down the Apple ( K) menu and choose About This Macintosh.

In the box that appears, “Total Memory” needs to be 4096K or more and the
number after “System Software” needs to be 7.0 or higher.

If you don’t know how much space your hard disk has available:
m Open the hard disk icon.

In the window that appears (showing the contents of the hard disk), look near
the upper-right corner, below the title bar, for a number followed by “MB
available.” The space available should be at least 4.5 MB. 

If you don’t know how many co lors your monitor displays:

1 Pull down the Apple ( K) menu and choose Control Panels.

2 Open the Monitors control panel to see how many colors your monitor displays.

If your co mputer has a CD-ROM drive: 

The CD-ROM drive is either built i nto the computer (usually next to the
floppy disk drive) or in a separate box connected to the computer.
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How to install WiggleWorks

1 Insert the WiggleWorks CD-ROM disc into the CD-ROM drive. Make sure you use a CD
caddy if your drive requires that you use one.

2 Open the Install WiggleWorks icon in the WiggleWorks CD-ROM disc window. You may
have to click the window’s scroll bars and scroll arrows to find it.

Do not open the icon labeled “WiggleWorks” before you install WiggleWorks.
Opening the WiggleWorks icon opens the program only after you’ve installed
WiggleWorks.

3 Click OK in the Installer program’s opening screen. 

4 If your computer has more than one hard disk, you can choose which disk you want
WiggleWorks installed on. Click Switch Disk until the disk’s name appears under the
phrase “on the hard disk named” in the Installer box.

5 Click Install.

The Installer program puts the WiggleWorks program and related files on
your hard disk. 

6 Click Restart or Quit in the box that appears when WiggleWorks has been installed. 

The WiggleWorks program should be in a folder on your hard disk. 

Af ter you’ve installed the program, you can open either the WiggleWorks icon
on your hard disk or the WiggleWorks icon on the CD-ROM disc when you
open a book (see next chapter).
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WiggleWorks is designed, of course, to be so easy that a child could use it. 
Still, a parent, guardian, or older sibling should

m help the child get started (described in this chapter)

m introduce the child to what she or he can do in the program (Chapters 3
through 6)

m change program settings to better suit the child (Chapter 7)

How to open a WiggleWorks book

IMPORTANT  If you have no more than 4 megabytes of memory, make sure that
no other programs are running while you’re using WiggleWorks.

1 Insert the WiggleWorks CD-ROM disc into the CD-ROM drive. 

2 Open the WiggleWorks icon in the WiggleWorks CD-ROM disc window. 

5
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An animation sequence introduces you to the WiggleWorks character.

At the end of the sequence, the character tells the child, “Sign in!”

3 Click Add Your Name.

4 Type the child’s name. You need to do this for every child who will be using
WiggleWorks, but only the first time each child opens a WiggleWorks book.

Subsequently, you or the child needs only to click the child’s name on the list.

5 Click Go.

Another animation sequence leads you to the Library screen, where you
choose which book you want to open.

Tip  You can cut an animation sequence short by clicking the
mouse at any time during the sequence.
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6 On the Library screen, click the book you want to open.

7 Click Go.

A third animation sequence leads you to the Activity Choices screen.
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8 On the Activity Choices screen, choose what you want to do in a book.

Go to the next chapter for a quick overview of the Library screen and the
Activity Choices screen.
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WiggleWorks has two main screens: 

m the Library Screen, where you choose the book that you want to open

m the Activity Choices screen, where you choose the activity that you want to do in the
book that you open

The next page summarizes the features of each screen.
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The Library screen

Click here to
go to a book
after you’ve
selected it.

Click a book to
select  it.

Click here to see the list
where readers sign in. 

Click here for a quick look at all the
pages of a book after you’ve selected it.

Click here to leave
WiggleWorks.

Click here if you
don’t know what to

do on a screen.



The Activity Choices s creen

Go to the next few chapters for more information on each activity area.
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Click here to have
the book read aloud.

Click here to use the
Magnet Board.

Click here to go back
to the Library screen.

Click here to
write on your
own.

Click here to
write your
own version
of the book.

Click here
to read the
book on
your own.





WiggleWorks lets children read a book in two activity areas:

m Read Aloud, where the program reads the text aloud and highlights the text 
as it does so

m Read, where children can read the text on their own

The next few pages summarize the features of each activity area.

15

C H A P T E R  4

Reading



Read Aloud cover page

Read Aloud inside page
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Click here for a message about what
you’ll learn in this book.

Click here to
go to the
next page.

Click here to
go to the
next page.

Click here to go
back to the Activity

Choices screen.

Click here to go to
the previous page.

Click here to hear
the text again.

Click here to hear
the text again. You
can also click any

word to hear it.

Click here to go back to the Activity Choices screen.



Read cover page

Read inside page
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Click here to go
back to the Activity

Choices screen.

Click here to go to
the previous page.

Click here to hear
the text read aloud.

Click here to hear
the text read aloud.

You can also click
any word to hear it.

If a microphone is connected to your
computer, click here to make a recording.

Click here to add words from the book to
your My Words list. See next section.

Click here to go
to the next page.

Click here for a message about
what you’ll learn in this book.

After you’ve made
a recording, click
here to hear it.



Using the My Words list

Children can use the My Words list to collect words used in a book that they
can use later in the Write, My Book, or Magnet Board activity areas.
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Click the
word that
you want to
remove from
the list, then
click the
minus sign.

Click here to
remove a
word that
you’ve
clicked on
the list.

Click the word that
you want to add to
your list, then click

the plus sign.

Click here to add a word that
you’ve clicked in the book.

Click here to put away the list.



To add a word to the My Words list:

1 Click the My Words button.

The My Words list appears.

2 Click the word in the book that you want to add to the list.

3 Click + (the plus sign) in My Words to add the word to the list.

To remove a word from the My Words list:

1 Click the word that you want to remove from the list.

2 Click - (the minus sign) in My Words to remove the word.

Children can print their My Words list either as a list or on individual cards
(one word to a page) that they can draw on, decorate, and arrange to make
sentences.

To print the My Words list:

1 Open the File menu and choose Print My Words.

2 In the box that appears, click Print List or Print Cards.

Deleting a recording in Read

You can delete a recording children have made by opening the Settings menu
and choosing Delete Recording.

Tip The menu bar is hidden until you move the pointer to the
top of the screen.

Tip The menu bar is hidden until you move the pointer to the
top of the screen.
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WiggleWorks has two activity areas for writing and drawing:

m Write, where children can write and draw their reactions and responses to the book

m My Book, where children can create their own version of the book by coloring and
changing the illustrations and by revising the text of the book

In both areas, you use the keyboard and the Cut, Copy, and Paste commands
in the Edit menu to type and edit text. You can also use the painting and
drawing tools.

The next few pages summarize the features of each activity area.
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Write

Using the painting and drawing tools
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Click here to go
back to the Activity

Choices screen.

Click here if you
need help getting

started. The program
will suggest a first

sentence.

If a printer is
connected to
your computer,
click here to
print what
you’ve written
and drawn.

Click here to
move up and
down the
text. You can
write up to
eight lines.

Click here to
use words in
the My Words
list.

Click here to hear
the text you’ve

written.

If a microphone is connected
to your computer, click here

to make a recording.

After you’ve
made a
recording, click
here to hear it.

Pour selected color
into closed shapes

with the paint bucket.

Draw circles and
ellipses with this tool.

Erase parts of your
drawing with this tool.

Click here to sweep
the drawing area

clean.

Click here to use
drawing and painting
tools.

Click a color to select it. All tools
use the selected color.

The color you select is shown here.

Click here to undo the last thing you did. (To undo everything you’ve
done on a My Book page, go to the Edit menu and choose Revert Page.)

Choose a rubber stamp and add its design to your drawing.

Draw squares and rectangles with this tool.

Draw lines and curves with the pencil (shown selected).
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My Book cover page

My Book inside page

If a printer is
connected to
your computer,
click here to
print what
you’ve written
and drawn. 

To change 
the text, select
it by clicking 
or dragging.
Then type 
new text to
replace it.

Click here to go to
the previous page.

Click here
to go to the
next page.

Click these buttons
to hear the text read

aloud. To hear
specific words, select

the words and then
click the button.

If a microphone is
connected to your

computer, click here
to make a recording.

Click here to go 
back to the Activity

Choices screen.

After you’ve made a recording, click here to hear it.

Click here to use words
in the My Words list.

Click here to use drawing
and painting tools.
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Using words from the My Words list

To add a word from the My Words list to your work 
in Write or in My Book:

1 Make sure the blinking insertion point is where you want to add the word.

2 Click the My Words button.

The My Words list appears.

3 Click the word on the list that you want to use.

4 Click + (the plus sign) to add the word to your composition.

Click a word,
then click the
plus sign to
add it to your
composition.
Click the
minus sign to
remove it
from the list.



Deleting a recording

You can delete a recording children have made by opening the Settings menu
and choosing Delete Recording.

Printing your work

In Write and in My Book, you can print your work by 

m clicking the printer button at the bottom of the screen or

m opening the File menu and choosing Print

In My Book, you have three pointing choices. You can print only the page that
you’re on, all the pages of the book, or the entire book in book format.

Click your choice in the box that appears when you print.

Hint: Print My Book in book format to get a coloring book for children to
color, even before they make any changes to the book on the computer.

Putting together sheets printed in book format

1 Two pages of the book are on each sheet. Fold each sheet in half crosswise (so that the
fold is at the top of each page).

2 Arrange the folded sheets in order. Every page has its page number in the bottom right,
and every odd-numbered page has a copyright notice in the bottom left.

3 Staple the sheets together along the left side.

Tip The menu bar is hidden until you move the pointer to the
top of the screen.

Tip The menu bar is hidden until you move the pointer to the
top of the screen.
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The Magnet Board activity area gives children a place to play with words and letters. 

This section summarizes the features of the Magnet Board.

Magnet Board
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Using the Magnet Board

Click a letter
or drag it to
the board.

Click here to switch
between capital

letters and lowercase
letters.

Click here to go 
back to the Activity

Choices screen.

Click here, then click
a letter on the board

to make it black.

Click here to frame a
group of letters together.

(See next page.)

Click here to hear
suggested activities.

Click here 
to print the
words on the
Magnet
Board.

Click here to
sweep the
board clean.

Click here to
use words in
the My Words
list.

Click here, then click letters on
the board to scramble them.
(See next page.)

This triangle points
to the place where
letters you click or

type will appear. 



Tips for using the Magnet Board

How to frame letters together. You frame a group of letters to keep them together.
Click the “cat” button. Hold down the mouse button as you drag the pointer
from the upper-left corner of the first letter to the lower-right corner of the
last letter. A red border surrounds the letters you have framed. 

Why scramble letters? When you click the Volcano button and click a group of
letters, the letters are scrambled all over the board. They become the same
color to make it easier to put the word back together. Scrambli ng a word is
also a good way to discover other words made from the same letters as the
original word.

Let’s hear it. You can click any word or letter on the board to hear it.

To delete a letter, drag it off the edge of the Magnet Board, or click the square to
its right (to position the triangle there) and then press the Delete key.

To replace a letter, drag another letter over it.

To copy a letter, hold down the Option key as you click the letter and drag the
copy to another square.
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You can change how a child uses a WiggleWorks book by

m changing the program settings while the child is using the book 
(the changes apply only during that session)

m changing the settings for the child (the new settings are in effect whenever
the child uses the program)

By adjusting the settings, you can make WiggleWorks easier for children who
are just beginning to read or who have trouble manipulating the mouse or
using the keyboard.

You can customize the program further for a child by

m recording messages that the child can play back in different activity areas

m changing the story starters used in Write

m changing the synthesized voice the computer uses in Write and 
in My Book

m adding or removing children’s names

31
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Changing settings for a single sess ion

To change the settings for a single session, use the items under the Settings
menu.

To change how much text is highlighted and read aloud:
m Choose Reading Style from the Settings menu.

Make your choices in the box that appears. 

If a child is just beginning to read or is having trouble following the story, you
may want smaller chunks of text highlighted and a slower reading pace.

“Step Word-by-Word” means that the program highlights and reads only a
single word each time you click.

To make the pointer larger so it is easier to see:
m Choose Bigger Cursors from the Settings menu.

Tip The menu bar is hidden until you move the pointer to the
top of the screen.
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To make the text larger and easier to read:
m Choose Large Text from the Settings menu.

When Large Text is checked, a magnifying glass appears on the page in Read
Aloud and Read. Click the magnifying glass to go back and forth between
normal-size text and large-size text. (In My Book and Write, you cannot
switch between text sizes.)

If the child has trouble manipulating the mouse:
m Choose Scanning from the Settings menu.

Make your choices in the box that appears. 
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Click here to switch
between normal-size
and large-size text.



When scanning is on, a scanning indicator (a black arrow in a blue square)
appears in the lower-left corner of the screen. 

To start the scan, the child clicks the mouse once. A black arrow points to the
options on the screen in sequence. To choose an option, the child clicks the
mouse again when the arrow points to that option.

You can interrupt the scan by pressing the Space bar on the keyboard.

“Scanning Cycles” i s the number of times the black arrow goes around the
different options before it stops.

If the child has trouble using the keyboard:
m Choose Screen Keyboard from the Settings menu.

Make your choices in the box that appears. You can have the letters arranged
either alphabetically or according to frequency of use in the English language.
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This indicates that
scanning is on.



When Screen Keyboard is on, an “alphabet block” button replaces the buttons
for Story Words and My Words in the Write and My Book activity areas.

Click the “alphabet block” button to open the screen keyboard.

You can switch between the Story Words and My Words lists by clicking the
button for each list.

To change how co lors are used i n text:
m Choose Custom Colors from the Settings menu.

Make your choices in the box that appears. 
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To have the names o f buttons and other options read aloud:
m Choose Talking Buttons from the Settings menu.

With Talking Buttons checked, the name of a button or option is read aloud
when you position the pointer over it. This feature is helpful for children who
are just beginning to read.

To have letters read aloud as they’re typed:
m Choose Talk and Type from the Settings menu.

With Talk and Type checked, each letter is read aloud as you type it (whether
you’re using the computer keyboard or the screen keyboard). This feature is
helpful for children who are just beginning to read.

Using the Parent menu

Only one item (Enter Password) appears in the Parent menu until you choose
that item and enter the password in the box that appears. 

To make the full Parent menu available:

1 Choose Enter Password from the Parent menu.

2 In the box that appears, type the password parent.

After you type the password, the full menu becomes available and remains
available until you quit WiggleWorks or until you choose Exit Parent Mode in
the menu.

Tip The menu bar is hidden until you move the pointer to the
top of the screen.
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Changing settings for a particular child

To change the settings for a particular child:

1 Open the Parent menu again and choose Edit Settings.

If the item isn’t in the menu, see “Using the Parent Menu” earlier in this
chapter.

Changes you make for a particular child using the Edit Settings item take
effect whenever that child signs in.

2 In the box that appears, you can change the following settings.

Activities

You can make an activity area unavailable to a child by clicking the area to
remove the X. You may not want beginning readers, for example, to wander
into the Write or My Book areas.
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Reading Style

For beginning readers, you may want to set the read-aloud pace slower and
have the text highlighted in smaller chunks. For more advanced readers, you
may want the read-aloud narration off.

Access O ptions

For beginning readers, you may want to check the Large Text, Talking
Buttons, Bigger Cursors, and Type and Talk options.
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For children with limited motor skill s who may have a hard time using the
mouse and the keyboard, you may want to check Scanning and Screen
Keyboard.

For color-bli nd readers, you may have to make adjustments by checking
Custom Colors. This option is also fun to personalize for children who have
strong preferences for certain colors.

Audio Options

More advanced readers may prefer to have the sound off, and some children
may prefer not to hear the computer’s synthesized voice (used in the Write
and My Book activity areas).
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Saving Options

You can determine in which activity areas children can save their work.
(Saved work is stored in the WiggleWorks folder on your hard disk.)

Recording or deleting messa ges for children

If a microphone is connected to your computer, you can leave recorded
messages to help children get what you want out of a book. 

You can record one message on each page of a book in Read Aloud, Read,
and My Book, and one message for each book in Write and Magnet Board. 

To record a messa ge

1 Go to the page where you want to leave a message.

2 Choose Record Parent Message from the Parent menu.

If the item isn’t in the menu, see “Using the Parent Menu” earlier in this
chapter.

3 In the box that appears, click Record, record your message, click Stop, and then 
click OK.
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When you’ve recorded a message on a page, a “comics balloon” button
appears near the lower-right corner of the page. The message is played back
(in your own voice) when children click the button.

To delete a messa ge

1 Go to the page that has the message you want to delete.

2 Choose Delete Parent Message from the Parent menu.

If the item isn’t in the menu, see “Using the Parent Menu” earlier in this
chapter.

To delete all messa ges
m Choose Delete All Parent Messages from the Parent menu.

If the item isn’t in the menu, see “Using the Parent Menu” earlier in this
chapter.
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This button appears when you’ve left a
message. Click it to hear the message.



Changing or adding story starters

You can change a book’s story starters or add your own that can be
personalized for a child. The story starters appear when the child clicks the
“li ght bulb” button in the Write activity area.

To change the story starters:
m Choose Edit Story Starters from the Parent menu.

If the item isn’t in the menu, see “Using the Parent Menu” earlier in this
chapter.

Changing the synthesized voice that the co mputer uses

You may want to change the synthesized voice if the selected voice does not
appeal to you or if the computer has difficulty producing the selected voice
because not enough memory is available.

1 Choose Computer Voice from the Settings menu or the Parent menu.

If the item isn’t in the Parent menu, see “Using the Parent Menu” earlier in
this chapter.

2 In the box that appears, open the pop-up menu to choose another voice.

The computer uses the voice you select in Write and in My Book. (In Read
Aloud and Read, the program plays back a recorded voice that’s stored on the
WiggleWorks CD-ROM disc.)

3 Click OK.
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Click here and hold
down the mouse button
to see a list of available
computer voices.



Adding or removing names

You can add or remove the names the of the children that are listed as your
WiggleWorks readers.

To add a name:

1 Go to the Sign In screen by opening the File menu and choosing Sign In or by clicking
the “clipboard” button, if it’s available.

2 Click Add Your Name.

In the box that appears, add the name.

To remove a name:

1 Go to the Sign In screen by opening the File menu and choosing Sign In or by clicking
the “clipboard” button, if it’s available.

2 Make sure the name that you want to remove is checked.

3 Choose Delete Name from the Parent menu.

If the item isn’t in the menu, see “Using the Parent Menu” earlier in this
chapter.

Suggested activities

Each book has suggested activities that you can do with the child or that the
child can do alone.

To see the suggested activities:
m Choose Suggestions from the Parent menu.

If the item isn’t in the menu, see “Using the Parent Menu” earlier in this
chapter.
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The File menu

Sign In Choose this to go to the Sign In screen, where readers sign in by
checking their names or adding their names to the list (see Chapter 2).

Library Choose this to go to the Library screen, where you can choose which
WiggleWorks book you want to open (see Chapter 2).

Open Other Book Choose this to open any WiggleWorks book you may have on
your computer system.

New Work Choose this to start a file in which children can save their work.

Open Work Choose this to open an existing file of a child’s work.

Save Work Choose this to save the work that a child is currently doing. The
first time you save a child’s work, a box appears where the program asks what
to name the file and where to store it on your computer system. (The box
appears with a name and a place—the WiggleWorks folder on your hard
disk—already suggested.)

Save Work As Choose this to save an existing file as a new file with another
name, so you can save different versions of a child’s work.
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Page Setup Choose this to set paper size and printing orientation.

Print Choose this to print what you have on screen. This command changes
depending on which activity area you are in.

Print My Words Choose this to print the contents of the My Words list.

Quit Choose this to leave WiggleWorks.

The Edit menu

Undo Choose this in Write and in My Book to undo the last thing you did.
This command applies to drawing and painting, not typing.

Cut Choose this to remove selected text in Write and in My Book and store
the text temporarily in the computer’s memory. You can then insert the text in
a different place by moving the text insertion point, going to the Edit menu,
and choosing Paste. (If you want to cut text and not paste it back, you can
select the text and then press the Delete key.) 

Copy  Choose this to copy selected text in Write and in My Book and store the
copy temporarily in the computer’s memory. (The original text remains where
it is in your writing.) You can insert the copy in a different place by moving
the text insertion point, going to the Edit menu, and choosing Paste.

Paste Choose this to insert text you’ve cut or copied in Write and in My Book.

Select All Choose this in Write and in My Book to select all the text.

Revert Page Choose this when you’re in My Book to restore the page to its
original state.
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The Go menu

Turn to page Choose this while you’re in Read Aloud, Read, or My Book to go
to a different page in the book. A box appears showing all the pages in the
book in reduced size (called thumbnails). Click the page that you want.

The rest of the items in this menu (Read Aloud, Read, Write, My Book, Magnet
Board ) take you to different activity areas without having to go to the Activity
Choices screen.

The Settings menu

Changes you make to WiggleWorks settings using the items in this menu
remain in effect only during the session in which you make them. (To make
changes that are in effect whenever a particular child is using the program,
use the Edit Settings command in the Parent menu.) 

For instructions on how to use each of these items, see Chapter 7. 

Reading Style Choose this in Read to set how the story is read and highlighted.

Computer Voice Choose this to set which voice you want the computer to use
when it reads text aloud in Write and in My Book.

Delete Recording Choose this to erase a recording from a page in Read, My
Book, or Write.

Bigger Cursors Choose this to use bigger pointers (such as the arrow and the 
I-beam used to set the text insertion point).

Large Text Choose this to make the text size larger. In Read Aloud and in
Read, a magnifying-glass button appears in the lower-right corner of the page
when Large Text is checked. Click the magnifying glass to shrink the text
(giving you a clear view of the illustration), and click the magnifying glass
again to enlarge the text. The magnifying glass is not available in My Book
and in Write.
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Scanning Choose this to enable a child to select program options without
having to move the mouse. When scanning is checked, a scanning indicator 
(a black arrow in a blue square) appears in the lower-left corner of the screen. 

To start the scan, the child clicks the mouse once. A black arrow points to the
options on a screen in sequence. To choose an option, the child clicks the
mouse again when the arrow points to that option.

You can interrupt the scan by pressing the Space bar on the keyboard.

Screen Keyboard Choose this to use an on-screen keyboard instead of the
computer keyboard.

Custom Colors Choose this to select the colors you want the program to use for
text, background, and text highlighting.

Talking Buttons Choose this to hear the program options and names of buttons
read aloud when you point to them on the screen.

Type and Talk Choose this to hear each letter spoken as you type it in Write,
My Book, Magnet Board, and the Sign In screen.

The Parent menu

Only one item (Enter Password) appears in the Parent menu until you choose
that item and enter the password in the box that appears. 

Af ter you enter the password, the full menu becomes available and remains
available until you quit WiggleWorks or until you choose Exit Parent Mode
from the menu.

For instructions on how to use each of these items, see Chapter 7. 

Enter Password You need to enter your password before the rest of the items in
this menu become available. Choose this and then type parent in the box that
appears.

Delete Name Choose this to remove a child’s name from the Sign In screen.
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Computer Voice Choose this to set which voice you want the computer to use
when it reads text aloud in Write and in My Book.

Edit Settings Choose this to change WiggleWorks settings for a particular
child. 

Edit Story Starters Choose this to change, add, or remove the story starters that
appear when you click the light-bulb button in Write.

Suggestions Choose this to read suggested activities you can do with a child or
a child can do alone.

Who’s Signed In Choose this to find out who is signed in to read a book.

Record Parent Message Choose this to record a message for children. You can
record one message on each page of a book in Read Aloud, Read, and My
Book, and one message for each book in Write and Magnet Board.

Delete Parent Message Choose this to erase the message from the page that 
you’re on.

Delete All Parent Messages Choose this to erase all the messages that you’ve
recorded for a book.

Exit Parent Mode Choose this to remove all the items (except Enter Password)
from the Parent menu. You will have to enter your password again to make the
items available.
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+ (plus sign), for adding to My Words list
18, 24

- (minus sign), for deleting from 
My Words list  18, 24

A

About This Macintosh (Apple menu),
checking memory on  2

access options, changing for a particular 
child  38–39

activity area, making unavailable  37
Activity Choices screen  8, 11, 13

changing options on  37
going back to

from Magnet Board  27
from My Book activity area  23
from Read activity area  17
from Read Aloud activity area  16
from Write activity area  22

adding to My Words list  18, 24
“alphabet block” button, for changing

screen keyboard  35
Apple menu

About This Macintosh, checking
memory on  2

Control Panels, checking monitor
colors with  2

audio options, changing  39. 
See alsoComputer Voice

B

background color, changing  35, 48
for a particular child  38, 39

Bigger Cursors (Settings menu)  32, 47

C

capital letters, switching to or from  23
CD-ROM drive, location of  2
changing text

Edit menu commands  40
in My Book activity area  19

changing the WiggleWorks program  31,
43

adding or deleting parent messages
40–41, 49

adding or removing children’s names
43, 48

changing or adding story starters  42,
49
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changing computer voice  39, 42, 47,
49

for a particular child  37–40, 48–49
changing access options  38–39
changing audio options  39, 49
changing available activities  37
changing reading style  38
changing saving options  42
using Parent menu  36

for a single session  32–36, 40–48
changing colors  35, 48
changing keyboard  34–35, 48
changing mouse scanning  33–34,

48
changing Reading Style  32, 47
enlarging pointer  32, 47
enlarging the text  33, 47
Talking Buttons  36, 48
Talk and Type  36, 48

checking for system requirements  2
Circle tool  22
“clipboard” button, adding or removing

child’s names with  43
color

changing  35, 48
for a particular child  38, 39

for drawing or painting  22
color-blind readers, changing display for

39
coloring book, printing  25
color monitor, requirements for  1, 2
“comics balloon” button  41
commands

Edit menu  46
File menu  45–46
Go menu  47
Parent menu  48–49
Settings menu  47–48

Computer Voice (Parent menu)  42, 49
Computer Voice (Settings menu)  42, 47
Control Panels (Apple menu), checking

monitor colors with  2
Copy (Edit menu)  46

copying a letter on Magnet Board  28
cursor. Seepointer
Custom Colors (Settings menu)  35, 48
customizing. Seechanging the 

WiggleWorks program
Cut (Edit menu)  46

D

Delete All Parent Messages (Parent
menu)  41, 49

Delete Name (Parent menu)  43, 48
Delete Parent Message (Parent menu)

41, 48
Delete Recording (Settings menu)  19,

28, 47
deleting. See entries beginning with

erasing
drawing

in My Book activity area  21, 23
printing  25
in Write activity area  21, 22

Drawing and Painting tools  22

E

editing
on Magnet Board  28
in My Book activity area  23

Edit menu  46
Edit Settings (Parent menu)  37–40, 45
Edit Story Starters (Parent menu)  42, 49
enlarging the pointer  32, 47
enlarging the text  33, 47
Enter Password (Parent menu)  36, 48
Eraser tool  22
erasing entire Magnet Board  27
erasing a letter from Magnet Board  28
erasing a reader’s name  43, 48
erasing a recording  19, 25

parent messages  41, 49
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erasing a word
from Magnet Board  28
from My Words list  18, 24

exiting WiggleWorks  46
Exit Parent Mode (Parent menu)  36, 49

F

File menu  45–46
Library  45
New Work  45
Open Other Book  45
Page Setup  46
Print  46

in My Book activity area  25
in Write activity area  25

Print My Book  25
Print My Words  19, 46
Quit  46
Save Work  45
Save Work As  45
Sign In  43, 45

framing letters on Magnet Board  27, 28

G

going to a book  12
Go menu  47

H

hard disk drive
installing WiggleWorks on  3
space requirements  1, 2

hardware requirements  1, 2
hearing a button name or option  36, 48
hearing a letter

on Magnet Board  28
as you type  36, 48

hearing the text
in My Book activity area  23
in Read activity area  17

in Read Aloud activity area  16
in Write activity area  22

hearing a word
on Magnet Board  28
in Read activity area  17
in Read Aloud activity area  16

hearing your recording  17, 23
Help button

on Library or Activity Choices screen
12, 13

in Write activity area  22
highlighting text  46

I, J

inserting text  46
installing WiggleWorks  1, 3
Install WiggleWorks icon  3

K

keyboard, changing appearance of
34–35, 48

for a particular child  38, 39

L

Large Text (Settings menu)  43, 47
letters, on Magnet Board

changing to black  27
choosing  27
deleting, replacing, or copying  28
framing or scrambling  27, 28
hearing  29

Library (File menu)  45
Library screen  7, 11, 12

going back to  12
light-bulb button, changing options for

42, 49
listening to text. Seehearing the text
looking through a book quickly  12
lowercase letters, switching to or from  27
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M

Magnet Board activity area  27–28
recording parent messages in  40–41,

49
Magnet Board button  13
Magnet Board (Go menu)  47
magnifying glass button  33, 47
memory requirements  1, 2. 

See also Computer Voice
menu bar, finding  19
menu commands  45–49

Edit menu  46
File menu  45–46
Go menu  47
Parent menu  48–49
Settings menu  47–48

Message button
“comics balloon” for parent message

41
hearing about book  16, 17
on Read Aloud cover page  16
on Read cover page  17

messages from parent
“comics balloon” button for  41
deleting  41, 49
recording  40–41, 49

microphone  1
recording parent messages with

40–41
recording with  17

Microphone button
in My Book activity area  23
in Read activity area  17
in Write activity area  22

minus sign (-), for deleting from 
My Words list  18, 24

monitor, number of colors required on  
1, 2. See alsoscreen display

mouse scanning
changing  33–34, 48
interrupting  48

moving around on screen, in Write
activity area  22

My Book (Go menu)  47
My Book activity area  21, 23

changing computer voice in  42, 47,
49

changing text in  23, 46
cover page  23
deleting a recording in  47
editing commands in  46
inside page  23
printing in  23, 25
recording parent messages in  40–41,

49
using My Words list in  24

My Book button  13
My Words list

adding words to  18, 24
printing  19, 46
removing words from  18, 24
using

in My Book activity area  23, 24
in Write activity area  24

My Words list button
on Magnet Board  27
in Read activity area  17
in Write activity area  18

N

names of readers, adding or removing
43–46

New Work (File menu)  45
Next Page button

in My Book activity area  23
in Read activity area  17
in Read Aloud activity area  16
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O

opening a book  5–8, 45
opening a child’s work file  45
opening WiggleWorks  3–5
Open Other Book (File menu)  45

P

page of your book, printing  25
Page Setup (File menu)  46
Paint Bucket tool  22
painting

in My Book activity area  21, 23
in Write activity area  21, 22

painting tools, using  22
Parent menu  48–49

Computer Voice  42, 49
Delete All Parent Messages  41, 49
Delete Name  43, 48
Delete Parent Message  41–49
Edit Settings  37–40, 49
Edit Story Starters  42, 49
Enter Password  36, 48
Exit Parent mode  36, 43
Record Parent Message  40–41, 49
Suggestions  43, 49
using  36
Who’s Signed In  49

Paste (Edit menu)  46
Pencil tool  22
plus sign (+), for adding to My Words list

18, 24
pointer

enlarging  32, 47
triangle  27

Previous Page button
in My Book activity area  23
in Read activity area  17
in Read Aloud activity area  16

Print (File menu)  46
in My Book activity area  25
in Write activity area  25

Printer button
in My Book activity area  23
in Write activity area  23

printing
coloring book  25
Magnet Board  27
in My Book activity area  23, 25
My Words list  19, 46
setting paper options for  46
in Write activity area  22, 25
your own book  23

Print My Book (File menu)  25, 46
Print My Words (File menu)  19, 46
program settings, changing. Seechanging

the WiggleWorks program

Q

Quick Look button  12
Quit (File menu)  46
Quit button  12

R

Read (Go menu)  47
Read activity area  12, 17–19

changing reading style in  32, 47
cover page  17
deleting a recording in  19, 47
enlarging text in  33, 47
hearing a recording in  17
inside page  17
making a recording in  17
recording parent messages in  40–41,

49
Read Aloud (Go menu)  47
Read Aloud activity area  15, 16

cover page  16
enlarging text in  33, 47
inside page  16
recording parent messages in  40–41,

49
Read Aloud button  13
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Read button  13
reading style, changing

for a particular child  38
for a single session  32, 47

Reading Style (Settings menu)  32, 47
recording  17

deleting  19, 24
hearing  17, 23
in My Book activity area  23
parent messages  40–41
in Write activity area  22

Record Parent Message (Parent menu)
40–41, 49

Rectangle tool  22
removing reader names  43, 48
replacing a letter, on Magnet Board  28
replacing text  23, 46
Restart box  3
restarting the computer  3
Revert Page (Edit menu)  46
Rubber Stamp tool  22

S

Save Work (File menu)  45
Save Work As (File menu)  45
saving, changing options for  40
Scanning (Settings menu)  43–44, 48
“Scanning cycles”  33, 34
scanning indicator  34, 46
scrambling letters on Magnet Board  27,

28
screen display. See alsomonitor

Activity Choices screen  11, 13
changing colors on  35
changing keyboard on  34, 35
changing for a particular child  38–39
enlarging pointer on  32
enlarging text on  33
Library screen  11, 12
moving around on, in Write activity

area  22

Screen Keyboard (Settings menu)  34–35,
48

Select All (Edit menu)  46
selecting a book  12
selecting a color, in Write activity area

22
Settings menu  47–48

Bigger Cursors  32, 47
Computer Voice  42, 47
Custom Colors  35, 48
Delete Recording  19, 24, 47
Large Text  33, 47
Reading Style  32, 47
Scanning  33–34, 48
Screen Keyboard  34–35, 48
Talking Buttons  36, 48
Talk and Type  36, 48

shrinking the text  39, 47
Sign-in button  12
Sign In (File menu)  45

for adding or removing names  43
signing in  6
Sign In screen

adding names to  43
removing names from  43, 48

software requirements  1
sound, changing  39

computer voice options  42, 49
for a particular child  42, 49
for a single session  42, 47

starting WiggleWorks  3, 5–8
“Step Word-by-Word” reading style  32
story starters, changing or adding  42, 49
Suggested Activities button, on Magnet

Board  27
Suggestions (Parent menu)  43, 49
Sweep tool  22

for Magnet Board  27
synthesized voice. Seesound
system requirements  1, 2
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T

Talk and Type (Settings menu)  36, 48
Talking Buttons (Settings menu)  36, 48
text

changing color of  35, 48
enlarging  33, 48

Tools box, in Write activity area  22
triangle pointer  27
Turn to page (Go menu)  47
typing new text, in My Book activity area

23

U, V

Undo (Edit menu)  46
Undo button, on Tools menu  22
voice, turning on or off  39. 

See Alsosound
“volcano” button, for scrambling letters

28

W, X, Y, Z

Who’s Signed In (Parent menu)  49
WiggleWorks CD-ROM disc, inserting  3
WiggleWorks folder, saving options for

40
word

adding to My Words list  18, 24
changing reading style for  32
deleting

from Magnet Board  28
from My Words list  18, 22

hearing
on Magnet Board  28
in My Book activity area  23
in Read activity area  17
in Read Aloud activity area  16

Write (Go menu)  47
Write activity area  21, 22

changing computer voice in  40, 47,
49

changing story starters in  40, 49
deleting a recording in  47
editing commands in  46
printing in  22, 25
recording parent messages in  38–41,

49
Write button  13
writing your own book. SeeMy Book

activity area


